ENTIS R110.1
Installation and Configuration Guide
ABOUT THIS GUIDE

This manual describes how to install and configure the ENTIS system. It has been written for the operators as well as system supervisors to provide them with all the information required to install and configure the system.

Safety and prevention of damage

‘Cautions’, and ‘Notes’ have been used throughout this manual to bring special matters to the immediate attention of the reader.

A Caution draws attention to an action which may damage the equipment.

A Note points out a statement deserving more emphasis than the general text, but does not deserve a “Warning” or a “Caution”.

Additional information

Contact Honeywell or its representative, if you require additional information. Also, refer to the list of related documents in Documentation References.

Legal aspects

The information in this manual is copyright property of Honeywell.

Honeywell disclaims any responsibility for personal injury or damage to equipment caused by:

- Deviation from any of the prescribed procedures
- Execution of activities that are not clearly documented

Copyright 2019 Honeywell. All rights reserved.

Reproduction in any form without the prior consent of Honeywell is not allowed. This manual is for information only. The contents, descriptions and specifications are subject to change without notice. Honeywell accepts no responsibility for any errors that may appear in this manual. The warranty terms and conditions applicable in the country of purchase in respect to Honeywell products are available from your supplier. Please retain them with your proof of purchase.
Support

For support, contact your local Honeywell Process Solutions Customer Contact Centre (CCC). To find your local CCC visit the website, https://www.honeywellprocess.com/en-US/contactus/pages/default.aspx

Revision History

<table>
<thead>
<tr>
<th>Documentation Reference</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETDOC-X613-en-101A</td>
<td>ENTIS Installation and Configuration</td>
<td>September 2019 (1st Release)</td>
</tr>
<tr>
<td>ETDOC-X613-en-110.1</td>
<td>Guide (This document)</td>
<td>December 2019 (R110.1)</td>
</tr>
</tbody>
</table>

Documentation References

The following list identifies publications that may contain information relevant to the information in this document.

<table>
<thead>
<tr>
<th>Documentation Reference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ETDOC-X612-en-110.1</td>
<td>ENTIS Quick Start Guide</td>
</tr>
<tr>
<td>ETDOC-X615-en-110.1</td>
<td>ENTIS User's Guide</td>
</tr>
<tr>
<td>EHDOC-X136-en-510A</td>
<td>Experion HS Software Installation</td>
</tr>
</tbody>
</table>


Contacts

See back page for details
### TABLES

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table 2-1</td>
<td>ENTIS as a Server</td>
<td>2</td>
</tr>
<tr>
<td>Table 2-2</td>
<td>ENTIS as a Client</td>
<td>2</td>
</tr>
<tr>
<td>Table 3-1</td>
<td>Software Requirements</td>
<td>3</td>
</tr>
<tr>
<td>Table 7-1</td>
<td>Scan Task Channel Properties</td>
<td>36</td>
</tr>
<tr>
<td>Table 7-2</td>
<td>User Scan Task Controller Properties</td>
<td>40</td>
</tr>
</tbody>
</table>
# FIGURES

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>DESCRIPTION</th>
<th>PAGE</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIGURE 1</td>
<td>ENTIS SETUP</td>
<td>5</td>
</tr>
<tr>
<td>FIGURE 2</td>
<td>NON-REDUNDANT ENTIS TOPOLOGY</td>
<td>10</td>
</tr>
<tr>
<td>FIGURE 3</td>
<td>NON-REDUNDANT ENTIS HOSTING REDUNDANT CIU’S TOPOLOGY</td>
<td>11</td>
</tr>
<tr>
<td>FIGURE 4</td>
<td>ENTIS REDUNDANT SINGLE NETWORK TOPOLOGY</td>
<td>12</td>
</tr>
<tr>
<td>FIGURE 5</td>
<td>SINGLE NETWORK CONFIGURATION</td>
<td>13</td>
</tr>
<tr>
<td>FIGURE 6</td>
<td>EXPERION COMMAND PROMPTS</td>
<td>16</td>
</tr>
<tr>
<td>FIGURE 7</td>
<td>CONNECTION PROPERTIES</td>
<td>21</td>
</tr>
</tbody>
</table>
1 INTRODUCTION

This guide introduces you to software & hardware requirements, prerequisites and procedures for installing ENTIS as a Server or Client system. This document provides information on how to configure an ENTIS system. It describes how to create Channels, Controllers & Equipment for an ENTIS system using Configuration Studio, and how to download them to an Experion server. In addition, it also explains how to export the database from a CIU 888 and how to configure the ENTIS license.

Reference document
For more information on using Configuration Studio, refer to Experion HS Configuration Studio Overview, EHDOC-X113-en-500.
2 HARDWARE REQUIREMENTS

The hardware systems that are recommended for installation and use of ENTIS as a Server and Client are given in the following tables.

2.1 ENTIS as a Server

Table 2-1: ENTIS as a SERVER

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel Xeon Processor E5-1620v3, 3.50GHz (or equivalent)</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>100 Mbps Ethernet</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1600x1200, 1680x1050, 1920x1200, 1920x1080; 65K colours</td>
</tr>
<tr>
<td>Hard drive</td>
<td>500GB</td>
</tr>
<tr>
<td>Example Hardware</td>
<td>Dell T5820XL Tower Workstation</td>
</tr>
<tr>
<td></td>
<td>Dell R7920XL Rack Workstation</td>
</tr>
</tbody>
</table>

2.2 ENTIS as a Client

Table 2-2: ENTIS as a Client

<table>
<thead>
<tr>
<th>System Configuration</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Single Intel Processor i3-4330, 3.50GHz (or equivalent)</td>
</tr>
<tr>
<td>RAM</td>
<td>8GB</td>
</tr>
<tr>
<td>Networking</td>
<td>100 Mbps Ethernet</td>
</tr>
<tr>
<td>Video resolution</td>
<td>1600x1200, 1680x1050, 1920x1200, 1920x1080; 65K colours</td>
</tr>
<tr>
<td>Video Memory</td>
<td>512MB VRAM per channel</td>
</tr>
<tr>
<td>Hard drive</td>
<td>500GB</td>
</tr>
<tr>
<td>Example Hardware</td>
<td>Dell OptiPlex XE2, OptiPlex 3040, HP 400G3 or equivalent</td>
</tr>
</tbody>
</table>
3 SOFTWARE REQUIREMENTS

The following software is required for the successful installation of ENTIS.

- Experion HS 510.2 server patch
  For access mail to HPSWeb@Honeywell.com

**The ENTIS installation will fail if installed on any operating system other than Windows 10 LTBS or in any environment other than Experion HS**

3.1 Prerequisite Software

ENTIS must be installed on a system where Experion HS 510.2 server patch is already installed and configured.


**Table 3-1: Software requirements**

<table>
<thead>
<tr>
<th>ENTIS Client/Server</th>
<th>Software</th>
<th>Specifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Microsoft Windows 10 Enterprise 2016 LTBS (64bit)</td>
<td></td>
</tr>
<tr>
<td>Browser type</td>
<td>Microsoft Internet Explorer 11</td>
<td></td>
</tr>
</tbody>
</table>
4 INSTALLATION OF ENTIS

4.1 Prerequisites

Prepare PC hardware and complete below pre-requisite installation using Experion HS manuals, Videos and ENTIS Manuals.

Ensure the following applications are available in the system before installing ENTIS:

Experion HS 510.2 Server patch

To install Experion HS 510.2 Server patch follow the instructions mentioned below:

1. Install: Win 10 LTBO OS with License (Delft factory will receive the OS media/DVD from ACT/Softco via Sales Order.
   • Refer the "windows 10 LTBO OS Installation video" from the below link:
   • https://www.honeywellprocess.com/en-US/online_campaigns/terminals/Pages/Terminals-HUB.aspx

2. Install: Experion HS R510.1 software + License (Delft factory will receive the media/DVD from ACT/Softco via Sales Order.
   • Refer the “Experion HS R510 - Installation and Basic Instructions” from the below link for the installation & Configuration.
   • https://www.honeywellprocess.com/en-US/online_campaigns/terminals/Pages/Terminals-HUB.aspx

3. Install: Experion HS R510.2 Software from HPSWEB. Delft Factory can directly download this patch from HPSWEB using the below link:

4. Experion HS R510.2 Server Patch 2. Delft Factory can directly download this patch from HPSWEB using the below link:

5. ENTIS R110.1 software + License (Delft factory will receive the media/DVD from ACT/Softco via Sales Order).
   • ENTIS Manuals can be found at:
   • https://www.honeywellprocess.com/en-US/online_campaigns/terminals/Pages/Terminals-HUB.aspx
4.2 Installing ENTIS as a Server

Perform the following steps to install ENTIS as a server in your system:

The installer application and the .NET framework 4.7.2 files are contained in the CD Drive ENTIS R101 folder within the disk. ENTIS uses .NET framework 4.7.2. If the appropriate framework version is not present in your system, the installer will install it for you. The restart of your computer is required following the installation of the .NET framework 4.7.2 framework.

![Figure 1: ENTIS Setup](image)

1. Right-click the installer application Setup in the disk and run it as Administrator.

   The ENTIS – Install Shield Wizard appears.

2. Click Next. The License agreement screen appears.
   Select the “I accept the terms…” option and click Next.
The Program Maintenance screen does not appear if you are installing ENTIS for the first time.

3. Click Next. The Custom Setup screen appears.
If .NET framework 4.7.2 is not present, ENTIS installer will only install when ‘ENTIS’ feature is selected for installation.

4. Select ENTIS and click Next. The Service account details screen appears.

5. Enter the Valid password for the ENTIS User account. Click Next.
6. Click Install.
After a successful installation, the **Install Shield Wizard Completed** screen appears.

*A restart is required after the installation is completed.*

The ENTIS application is successfully installed in your system as a server.
5 Installing ENTIS with Redundancy

Depending on the network topology, extra steps might be required. Please follow the directions of the chapter related to your network topology to implement ENTIS at your site.

- Non-redundant
- Non-redundant ENTIS hosting redundant CIU’s
- Redundant with single network

5.1 Non-redundant

The next figure will show the topology of a non-redundant ENTIS connected to a non-redundant CIU 888.

No additional steps are required for redundancy.
You can continue with chapter 6.

Figure 2: Non-redundant ENTIS topology
5.2 Non-redundant ENTIS hosting redundant CIU’s

The following figure shows the topology of ENTIS on a single server hosting a redundant pair of CIU’s 888.

This topology does not require extra commissioning steps for ENTIS. You can continue with chapter 6.
5.3 Redundant with Single network

ENTIS redundant with single network is based on the topology.

Figure 4: ENTIS redundant single network topology

To commission ENTIS for the topology pictured above, the following steps need to be performed.

5.3.1 Prerequisites

Ensure the following:

- The host names of both systems comply with the rule for Experion. This means the host name of one system ends with the character “a” and the other with “b”.
- Ensure that both servers have Experion and ENTIS installed, are connected to the same network and turned on.
5.3.2 Commissioning

Commissioning of redundancy starts with steps to commission Experion to support a single network. These steps need to be performed after having installed Experion and Entis.

The following sections describe the steps to configure the hosts file, define the arbitration and setup the data links between the servers.

**Configure the host file**

During commissioning of the Single Network Redundancy topology (Topology H12), see Figure 5, the hosts file need to be constructed according the following instructions.

In a single network configuration without Backup Control Center (BCC), both servers are connected on a single network and have a single network card installed. Figure 5 shows an example of a single network configuration.

![Figure 5: Single network configuration](image)

In this example the TCP/IP address of hsserva is 192.168.0.1 and the TCP/IP address of hsservb is 192.168.0.2. Add the following lines to the hosts files:

- # TCP/IP address for primary
  - 192.168.0.1 hsserva hsserva0
- # TCP/IP address for backup
  - 192.168.0.2 hsservb hsservb0
5.3.3 Configure arbitration

The Experion command prompt referred to in the next section can be located at: C:\ProgramData\Microsoft\Windows\All Honeywell tools\Server\Diagnostic Tools\Experion Command Prompt.lnk

The arbitration method to be used in your redundant server system must be defined for the primary and backup servers.

An example hardware definition file (which you can modify and use) is shipped with Experion. The file name is redun.hdw and is located in <data folder>\Honeywell\Experion PKS\Server\User, where <data folder> is the location where Experion data is stored. For default installations, <data folder> is C:\ProgramData.

Prerequisites
- You must stop the Experion server before using the hdwbld utility.

To define the arbitration method
1. In any text editor, open or create your hardware definition file.
2. Add the following entry to the hardware definition file:
   
   DEL PSW00
   
   ADD PSW00 NETWORK_PSW RECOVER=recover_option
   
   IDLE=10 READ=15
   
   Where the recovery option is ABORT or REBOOT.
   ABORT means that when a failover occurs, Experion server service is stopped and restarted on the failed server. REBOOT (the recommended option) means that when a failover occurs, Experion server service is stopped and the database unloaded on the failed server. The Experion server service is then restarted.
   
   3. Save the file and copy to the primary and backup servers.
   4. Type the following:
      
      hdwbld filename.hdw
      
      where filename is the path and filename of the file you created in the text editor.
   5. Repeat the above step on the backup server.

Example:
The following hardware definition file entries are for a redundant server system with software arbitration. When a failover to the backup server occurs, Experion is stopped and restarted on the primary server.

DEL PSW00

ADD PSW00 NETWORK_PSW RECOVER=ABORT IDLE=10 READ=15
Defining the data links
When the primary and backup servers are running in redundant mode, all database changes on the primary server are sent to the backup server via data link. (A data link is a network path between the primary server and the backup server.)
A hardware definition file must be created defining the data links. This file must be built individually on both servers (using the hdwbld utility).

The example hardware definition file <data folder>Honeywell\Experion PKS\server\user\redun.hdw also includes data link definition examples. Where <data folder> is the location where Experion data is stored. For default installations, <data folder> is C:\ProgramData. The C:\ProgramData folder is a system folder, which means that it is only visible if you select the Show hidden files, folders, and drives option button in the Folder Options dialog box. To change this setting in Windows Explorer, click Organize > Folder and search options, and then click the View tab.

To build the data link for a single network
1. Open a text editor such as Notepad.
2. Add the following entry to the file:
   
   DEL LNK00
   ADD LNK00 NETWORK_LINK

3. Save the file with a .hdw extension.
4. On the primary server, open the Experion Command Prompt window. To run Experion commands, you must be a member of the Product Administrators group. If you want to do engineering tasks, you must be a member of the Local Engineers group. You must run Experion commands from the Experion command prompt and not the standard Windows command prompt, otherwise you will not see the output from the command and the command will fail.
5. Type the following:
   
   hdwbld filename.hdw

   where filename is the path and filename of the file you created in the text editor.
Figure 6: Experion Command Prompts
5.4 Configuring ENTIS for File Replication

In the redundant configuration for ENTIS, there are artifacts that must be synchronized between the redundant servers. ENTIS leverages the Experion File Replication service, which must be configured by following these steps:

- Open Honeywell Experion Station:
- Open the Windows Start Menu
- Select Honeywell Experion → Experion Station
- Log in as a user with Manager permissions
- Open the file replication configuration page in Station via the top menu bar
  CONFIGURE → File Replication

The ENTIS Installer will create the correct shared network folders, with the proper access permissions, for the replication service to work properly.

Select an empty row at the bottom of the list
The edit page will open

To Change the settings and fields, one must confirm each edit by pressing the “Enter” key.

1. Definition changes:
   - Name: EntisRepository
   - Path (will populate automatically to the created shared folder)
   - Select “Replicate files from this path”
   - Select “Postpone replication if files are in use by another application”

2. File selection changes:
   - Select “Include subdirectories”
   - Deselect “Overwrite existing files (even if newer)”
   - Select “Auto purge/mirror files”

3. Schedule changes:
   - Deselect “Replicate every day at”
   - Select “Replicate automatically whenever files change”

4. Destination changes:
   - Select “Specific PC’s”
   - Set the PC name to `<servername>-B`
   - Confirm green indicator if `<servername>-B` is running

5. Click “Save”
6. Click “Replicate Now”
7. Confirm status “OK”
8. Go back to CONFIGURE → File Replication
9. Select “Send” box at the “EntisRepository” entry
This configuration must be repeated on the redundant server (Server-B) with one difference:
Destination changes:
- Select “Specific PC’s”
- Set the PC name to <servername>-A
- Confirm via green indicator if <servername>-B is running
5.5 Configuring ENTIS for data synchronization

Prerequisites:

1. Entis on both Primary and Backup servers.
   - Includes the configuration and installation of Experion.
   - Entis installer will create the files and network shares with the right permissions.

2. Experion File Replication setup on both Primary and Backup servers.

To configure Redundancy features for ENTIS, do the following on the Primary server:

i. In Windows Explorer, **Open** the folder:
   `<ENTIS install directory>\Redundancy`

ii. **Locate** “RunRedundant.bat” file
   - Double click the “RunRedundant.bat” file

Script output:

iii. **Reboot** the Backup server
5.6 Configuring Station connections for Server Redundancy

Stations need to connect to whichever server is running as the primary server. However, special Station configuration is required for local and network-connected Stations to locate and connect to the server running as primary.

To configure the station connections:

1. Start Experion Station on the Primary Server
2. On the top menu bar goto “Station”, “Connect…”
3. Select “Entis”
4. → Edit Connection.. (opens connection properties window)

5. Type <the server name of the Backup server> in “Server(s)” followed by Enter (Server name = “server-b”, see Figure 7)

6. Select “Auxiliary setup file”
7. → Browse.. → Select “Default.stn” → Open
8. → Save as .. hsservb.stn → Save
9. → Cancel (closes connection properties window)
10. Select “Entis”
11. → Edit Connection.. (opens connection properties window)
12. Type < the server name of the Primary server> in “Server(s)” followed by Enter
13. Select “Auxiliary setup file”
14. → Browse.. → Select hsservb.stn → Open
15. → Save as .. Default.stn → Save (Overwrite)
16. Close Experion Station on the Primary Server, Start Experion station on the Backup Server
17. Repeat steps 2..15 on the Backup server, use the following in below steps:
   • step 5 <the server name of the Primary server>
   • step 12 <the server name of the Backup server>
   • step 8 and step 14 hsserva.stn

With this configuration the station connects to the server defined in the default.stn. when this connection fails or gets lost, the station re-connects to the server defined in the Auxiliary setup file.

Continue with chapter 6
6 Installing ENTIS as Client or User Interface

Perform the following steps to install ENTIS as Client or User Interface in your system

**For Client/User Interface only, not for Server use**

1. Perform steps 1 and 2 from section 4.2 procedure above.
2. In the Custom Setup screen, click the drop-down button to the left of ENTIS and choose This feature will not be available option.
3. Select the option ENTIS User Interface.
4. Click Next.
5. Follow the remaining steps from the previous procedure to complete installing ENTIS as client in your system.
6.1 Verifying successful installation

Perform the following steps to ensure that ENTIS is successfully installed in your system.

1. In the Experion Station, go to STATION>Connect to view the Connect window listing ENTIS as shown below.

2. Click Connect.

3. ENTIS appears on the main menu of the Experion Station as shown below.

You have verified that the ENTIS application has been successfully installed in your system.
7 CONFIGURING THE ENTIS SYSTEM

Configuring ENTIS means to customize the Experion server database for your plant. It involves defining communication connections, and the data acquisition and control that you want to implement at your site.

ENTIS is configured according to the end user requirements using Configuration Studio, which is installed as a part of the Experion installation.

7.1 Starting Configuration studio

Prerequisites
You must have an Experion operator account on the Experion server to which you want connection.

*If this is a new installation, use the default mngr account.*

To start the Configuration Studio:

Perform the following steps to start Configuration studio:

Choose **Start > All Programs > Honeywell Experion PKS > Configuration Studio.**

The Configuration Studio window appears.

1. Go to **File > Connect** to open the Connect dialog box.
2. In the **Connect** dialog box, click **Other Targets** tab.
3. In the **Target Type** drop down box, select **Experion System.**
4. In the **Target Name** text box, type *localhost*
   Alternatively, you can specify the IP address of the server.

5. Click **Connect**.

6. Log on to Configuration Studio.

   **Select a system when you want to configure your asset model, configure your Network tree, or select a server for specific tasks.**

   a. Type the operator name and password.

   b. In the Domain list, select one of the following:

<table>
<thead>
<tr>
<th>If...</th>
<th>Select...</th>
</tr>
</thead>
<tbody>
<tr>
<td>The operator name is maintained in a</td>
<td>The Windows domain name</td>
</tr>
<tr>
<td>Windows domain</td>
<td></td>
</tr>
<tr>
<td>The operator name is maintained on the</td>
<td><em>Servername</em> (the target)</td>
</tr>
<tr>
<td>server or system that you are connecting,</td>
<td></td>
</tr>
<tr>
<td>and you use integrated security</td>
<td></td>
</tr>
<tr>
<td>You are using traditional operator security</td>
<td><em>&lt;Traditional Operator Security&gt;</em></td>
</tr>
</tbody>
</table>

   c. Click **OK**.
7. Results: Configuration Explorer is populated with a tree of items that you can configure for your system as shown below.
7.2 Configuring Assets

Assets are items that make up the asset model.

**Prerequisites**
You have a security level of ENGR or higher. See Refer to ENTIS User’s Guide, ETDOC-615-en-R101, see Documentation References

- You have launched Configuration Studio and connected to an Experion system.
- You can only configure assets within an Experion system.
- You cannot configure assets when connected only to an Experion server.
- You have already configured the system and added servers to the system using Configuration Studio.

To configure assets:

1. In the Configuration Explorer in Configuration Studio, select the highest-level system node.
2. In the right pane, under System Tasks, click Configure Assets for this system.

3. The Enterprise Model Builder - Asset window appears. The left side of the window shows an Asset tree view containing the asset model structure.
4. If the Asset tree view window is not visible, click Open Tree on the toolbar to open the asset model.

5. Choose File > New ASSET. The **ASSET Block Parameters** dialog box appears.
6. In the **Tag Name** box, Enterprise Model Builder has already assigned a default tag name. Type a new unique tag name.

7. In the **Item Name** box, Enterprise Model Builder has already assigned a default item name. Type another item name, if you require a different item name.

8. In the **Description** box, type a description of the asset.

9. In the **Point Detail Page** and **Associated Display** boxes, type the name of the associated displays.

10. Select the **Directly Assignable** (for scope of responsibility and alarm enable/disable) check box if you want the asset to be assignable to an operator, Station, or alarm group. The icons for unassigned assets in the Asset tree view appear dimmed.

11. Click the **Identification** tab.

12. In the **Block Comment** boxes, type additional information about the asset.

13. Click **OK** to create the asset. The asset appears in the Asset tree view.

**You can arrange assets within the asset tree view by the clicking on the asset icon, and then dragging and dropping the icon to the new location.**
7.3 Loading Asset Model on to Servers in the System

The asset model can be loaded to servers that are configured as part of the Enterprise Model. The asset model can be loaded to the Experion server.

This operation loads the entire asset model to the selected servers. The entire model includes the system configuration and all defined items in the model, which includes the top-level asset and all assets groups associated with that item. Individual assets cannot be loaded; assets are loaded as a model.

During the load operation, assets and points may temporarily belong to unassigned items in the Alarm Summary display. The tree view on the left of the display may show an incomplete model. These conditions should clear once the download is completed. When you start the load process, all items of the Asset model and all configured servers selected for load are locked to other users. If the asset model to be loaded is already locked, an error is reported and the load operation is aborted. If any of the configured servers are already locked an error is reported and the load operation is aborted.

Prerequisites

- You have a security level of ENGR or higher.
- A system model has been defined, consisting of at least one server.
- An asset model, have been defined.
- You have the Enterprise Model Builder window open with either an Asset tree view displayed.
To load the asset model onto servers in the system:

1. In Enterprise Model Builder, choose Tools > Load Entire Model or click Load Entire Model on the toolbar. The Enterprise Model Builder - Load window appears.

2. In the Load column, select the check boxes of the servers that you want to download the asset to. Clear the check box of any servers that you do not want to load asset to.

   ![Enterprise Model Builder - Load window](image)

   **If no servers are selected, the OK button is disabled.**

3. If required, select the Force Load check box to allow the load to proceed even if the system name or repository name has changed.

4. Click OK to begin the asset or alarm group load to the selected servers.
The Loading Asset dialog box appears, showing the name of the top-level asset or alarm group that is being loaded. A progress bar shows the duration of the load operation.

Results

The load operation validates all server names of all the configured servers in the system, as well as the point and full item names of the asset model.

If the load operation is successful without detection of any errors or warnings, a load status of Complete appears.

If any errors occur during the load operation, correct the fault and then perform the load procedure again.

Use the online help manual to get more information about the page at any point of time within the application. Press F1 to access Online help.
7.4 Building Channels

Channels are the communications link between controllers and the Experion server. You can build SCADA channels using Quick Builder in Configuration Studio.

To build a channel using Quick Builder

1. In the Configuration Explorer tree, click Control Strategy to view the menu option on the right pane.

2. In the right pane, under SCADA Control, click on Build channels. The Channels window appears.
3. In the **Channels** window, right-click and choose **Add Items** menu option. The **Add Items** dialog box appears.
   In the **Number of Items** text box, type the number of channels you want to add.

4. From the **Item Family** list, select **Channel**.

5. From the **Item Type** list, select **User Scan Task Channel**.

6. In the **Name** text box, type in the name for this channel, or you can accept the default provided. If you have chosen to create multiple channels, the Multi – Items section is enabled, and you can provide a prefix for all the channels, or you can accept the default provided. You can also indicate whether to use a sequential number or letter to differentiate between the channels.

   **When building controllers and channels for use with equipment, or to be referenced by Equipment Templates, do not include underscores or hyphens in the names specified for the controller or channel.**

```
Add Items

<table>
<thead>
<tr>
<th>Number of Items:</th>
<th>Remaining: 96</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item Family:</td>
<td><strong>Channel</strong></td>
</tr>
<tr>
<td>Item Type:</td>
<td>--------------</td>
</tr>
<tr>
<td></td>
<td>ControlEdge PLC Channel</td>
</tr>
<tr>
<td></td>
<td>User Scan Task Channel</td>
</tr>
</tbody>
</table>

Name: CHAUSE3
Summary: Add item named CHAUSE3
```

7. Click **OK** to add the channel(s) to the list.

   **Alternatively, you can also drag and drop the channels from the right panel to the Channels window to create Channel.**
8. Main properties of a user scan task channel. The Main tab defines the basic properties for a user scan task channel.

**Table 7-1: Scan Task Channel properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the channel. A maximum of 10 alphanumeric characters (no spaces or double quotes). Note: In Station displays, underscore characters ( ) appear as spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) A description of the channel. A maximum of 132 alphanumeric characters, including spaces.</td>
</tr>
<tr>
<td>Associated asset</td>
<td>The ENTIS asset that an operator must have access to in order to see system alarms from this system interface.</td>
</tr>
<tr>
<td>Marginal Alarm Limit</td>
<td>The communications alarm marginal limit at which the channel is declared to be marginal. When this limit is reached, a high priority alarm is generated. To change the priority of the alarm system wide, see the topic titled &quot;Configuring system alarm priorities&quot; in the <em>Server and Client Configuration Guide</em>. To change the priority of the alarm for one channel, see the topic titled &quot;About configuring custom system alarm priorities for an individual channel or controller&quot; in the <em>Server and Client Configuration Guide</em>.</td>
</tr>
<tr>
<td></td>
<td>A channel barometer monitors the total number of requests and the number of times the controller did not respond or response was incorrect. The barometer increments by two or more, depending on the error, and decrements for each good call.</td>
</tr>
<tr>
<td></td>
<td>To calculate an acceptable marginal alarm limit, use the formula: Square root of the number of controllers on the channel × Marginal Alarm Limit defined on those controllers (Normally, you specify the same value for all controllers on a channel).</td>
</tr>
<tr>
<td></td>
<td>For example, if there are 9 controllers on the channel and their Marginal Alarm Limit is set to 25, the value would be 3 (which is the square root of 9) × 25 = 75.</td>
</tr>
<tr>
<td>Fail Alarm Limit</td>
<td>The communications alarm fail limit at which the channel is declared to have failed. When this barometer limit is reached, an urgent alarm is generated. To change the priority of the alarm system wide, see the topic titled &quot;Configuring system alarm priorities&quot; in the <em>Server and Client Configuration Guide</em>. To change the priority of the alarm for one channel, see the topic titled &quot;About configuring custom system alarm priorities for an individual channel or controller&quot; in the <em>Server and Client Configuration Guide</em>.</td>
</tr>
<tr>
<td></td>
<td>Set this to double the value specified for the channel Marginal Alarm Limit</td>
</tr>
<tr>
<td>Item Type</td>
<td>Shows the channel type.</td>
</tr>
<tr>
<td>Last Modified</td>
<td>Shows the date of the most recent modification to this channel's property details.</td>
</tr>
<tr>
<td>Item Number</td>
<td>The unique item number currently assigned to this item. You can change the item number if you need to match your current server database configuration. The number must be between 1 and the maximum number of channels allowed for your system (the maximum is shown on the Sizing tab for the server).</td>
</tr>
<tr>
<td>Last Downloaded</td>
<td>The date on which the item was last downloaded to the server.</td>
</tr>
</tbody>
</table>
7.4.1 Downloading the Channels

The channels that are created are to be downloaded to the Experion server.

To download the channels to server:

1. Click the download button on the tool bar. The **Download** dialog box appears.

2. Click Download. The channel created will be downloaded to Experion server.
3. The **Results** message box will be displayed after successful completion of download.
4. Click **OK**.
7.5 Building Controllers

Controllers are devices used to monitor and control processes and items of field equipment. A controller is linked to the Experion server by a Channel. You can build SCADA controllers using Quick Builder in Configuration Studio.

To build a Controller using Quick Builder:

1. In the **Configuration Explorer** tree, click **Control Strategy** to view the menu option on the right pane.
2. Under SCADA Control, click on **Build Controllers**.

The **Controllers** window appears.

3. In the **Controllers** window, right-click and choose **Add Items** menu option.
The **Add Items** dialog box appears.

4. In the **Number of Items** text box, type the number of controllers you want to add.
5. From the **Item Family** list, select **Controller** family
6. From the Item Type list, select **User Scan Task Controller**
7. In the **Name** text box, type in the name for this controller, or you can accept the default provided.
8. Click **OK** to add the controller(s) to the list.

**Main properties for a user scan task controller**

The **Main** tab defines the basic properties for a user scan task controller.

**Table 7-2: User Scan Task Controller properties**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The unique name of the controller. A maximum of 10 alphanumeric characters (no spaces or double quotes). Note: In Station displays, underscore characters (_) appear as spaces.</td>
</tr>
<tr>
<td>Description</td>
<td>(Optional) A description of the controller. A maximum of 132 alphanumeric characters, including spaces.</td>
</tr>
<tr>
<td>Associated asset</td>
<td>The asset that an operator must have access to in order to see system alarms from this system interface. If you leave the associated asset field empty, the system alarms for this system interface will be seen by anyone who has access to the system alarms for the server on which this system interface is configured.</td>
</tr>
<tr>
<td>Channel Name</td>
<td>The name of the channel on which the controller communicates. (You must have already defined the generic channel so that it appears in this list.)</td>
</tr>
</tbody>
</table>
**Marginal Alarm Limit**

The communications alarm marginal limit at which the controller is declared to be marginal. When this limit is reached, a high priority alarm is generated. To change the priority of the alarm system wide, see the topic titled "Configuring system alarm priorities" in the *Server and Client Configuration Guide*. To change the priority of the alarm for one controller, see the topic titled "About configuring custom system alarm priorities for an individual channel or controller" in the *Server and Client Configuration Guide*.

A controller barometer monitors the total number of requests and the number of times the controller did not respond or response was incorrect. The barometer increments by two or more, depending on the error, and decrements for each good call.

The default value is 25.

| Fail Alarm Limit | The communications alarm fail limit at which the controller is declared to have failed. When this barometer limit is reached, an urgent alarm is generated. To change the priority of the alarm system wide, see the topic titled "Configuring system alarm priorities" in the *Server and Client Configuration Guide*. To change the priority of the alarm for one controller, see the topic titled "About configuring custom system alarm priorities for an individual channel or controller" in the *Server and Client Configuration Guide*.

Set this to double the value specified for the controller Marginal Alarm Limit.

The default is 50. |
|------------------|---|

<table>
<thead>
<tr>
<th>File Number Record Number</th>
<th>The file and record number of the user table that this 'controller' represents.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>LRN Number</th>
<th>The logical resource number of the user scan task to be notified of point control requests. This entry specifies the LRN of a user scan task written with the Application Programming Interface. (For details about writing a user scan task, see the <em>Application Development Guide</em>.)</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Shows the controller type.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Last Modified</th>
<th>Shows the date of the most recent modification to this controller's property details.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Item Number</th>
<th>The unique item number currently assigned to this item. You can change the item number if you need to match your current server database configuration. The number must be between 1 and the maximum number of channels allowed for your system (the maximum is shown on the Sizing tab for the server).</th>
</tr>
</thead>
</table>

| Last Downloaded | The date on which the item was last downloaded to the server. |
7.5.1 Downloading Controllers

The channels that are created are to be downloaded to the Experion server.

To download the Controller to server:

1. Click the download button on the tool bar. The Download dialog box appears.

2. Click Download.

3. The Controller created will be downloaded to Experion server.
4. The **Results** dialog box appears after successful completion of download.

   ![Results dialog box]

   Download Successful.

   For further details, double click on files below:

<table>
<thead>
<tr>
<th>File</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>QBDB.hdw</td>
<td>C:\ProgramData\Honeywell\Qui...</td>
</tr>
</tbody>
</table>

5. Click **OK**.
8 MIGRATING CIU 888 DATABASE

Database is created using CIU 888 Service Tool and Migrated to ENTIS.

**Prerequisites**
Maintain Modbus map name as: NewEntis and Unit ID as: 1 in CIU 888 service tool for ENTIS complaint Modbus map.

**Perform the following steps to migrate the CIU 888 database for ENTIS.**

*You must be a system administrator to perform the database export.*

To start the ENTIS Configuration tool:

Perform the following steps to start the Configuration Tool:

1. Choose Start > All Programs > Honeywell Entis
   Right click on Configuration Tool > More > Run as administrator. The following window appears.

2. Click Yes.
The Entis Configuration Tool will appear

3. Press Upload Files.

4. Browse to the CIU 888 database using the file dialog

5. Select the CIU 888 file(s) and press Open.
6. When all files are successfully loaded the **Migrate** button will be enabled.

7. Press the **Migrate** button
8. When the next screen appears, the ENTIS database is ready and you will be asked if you also want to create point files.

9. Press No if you have created the point files before and Close the application by clicking X in the upper right corner.

10. Press Yes if this is the first time migrating. The program continues with the next screens.
12. For each tank in the system a screen like the one below will appear and automatically disappear.

Do not close the ENTIS Configuration Tool while the point files get generated.
13. When all point files have successfully been created, the following screen appears.

Point file creation time varies depending on the size of the database.


15. The application can now be closed by clicking X in the upper right corner.
8.1 Downloading the Equipment Templates

Experion uses the term *Equipment* to represent physical equipment in a plant, such as well heads, pumps, generators. Equipment typically has many associated items – points, channels, controllers – so templates have been created on which you can base new equipment, therefore making the task much quicker and simpler than creating everything individually. You can build Equipment using Quick Builder in Configuration Studio.

**To build Equipment using Quick Builder:**

1. In the Configuration Explorer tree, click Control Strategy to view the menu option on the right pane.

2. Under SCADA Control, click on Build equipment. The *Equipment* window appears.

3. In the Equipment window, go to File → Import. The Select file to Import dialog box appears.
4. Choose the path
C:\Users\Public\Documents\Honeywell\ENTIS\EquipmentTemplate

6. From the Files of Type list, select Equipment Template

7. Select all the files displayed in the window and click Open. The template files are to import to Experion HS server.

8. The Results message box appears after successfully importing the equipment templates.
9. Click OK.

10. In the **Library** panel, on the right-hand side, you can view the equipment under **Oil and Gas Library**.
9 CREATING FLEX OR CLIENT STATIONS
(Multi user)

You can create and configure more than one station using Quick Builder.

To create a Station using Quick Builder:

1. In the Quick Builder window tree view, click Stations. The Stations window appears.
2. In the Stations window, right-click and select the Add Items. The Add Items dialog box appears.
3. Type the number of items you want to create in the Number of items field. If you choose to create more than one item, extra fields appear where you can define the suffix applied to each item name. The variable used can be numbers of letters.
4. From the Item Family list, select the applicable family. If you used a template or a right-click menu option to invoke this dialog, this field will default to the template type or the item you had selected at the time.
5. From the Item Type list, select the item type.
6. In the Name text box, type in the name for this item, or you can accept the default provided. A summary of the details you have provided is displayed.
7. Click OK to add the item(s) to the list.
8. The new items appear in the List View.
9. Click the download button on the toolbar.
The Download window appears.

10. Click the Download button.
11. The Results message box will be displayed after successful completion of download.

12. Click OK.
10 SETUP LOGGING SETTINGS

In Experion station go to menu configure → system hardware → Server wide settings

Uncheck the Disable writes via the Network API check box in Server Wide Settings.

The checkbox must be unchecked to be able to see ENTIS events in Experion station.
11 INSTALLING THE ENTIS LICENSE

License file should be named ENTISR101.lic and placed in the following path: C:\ProgramData\Honeywell\ENTIS\License.

The installer will create the folder, but the License file should be placed manually. Scanner will work only if there is valid license from the current build. When there is no valid license found in the path, ENTIS station will throw an error message as shown below.

Uninstall ENTIS program

1. Open the Start menu.
2. Type “Control Panel” and select.
3. Select “Programs and Features” to display “Uninstall or change a program” screen
4. Select ENTIS app from the list to uninstall.
5. Click the Uninstall button that appears.
## INDEX

A

ABOUT THIS GUIDE ...................................................... ii

B

Building Channels ....................................................... 34
Building Controllers .................................................... 39

C

Configuration Studio .................................................. 25
Configuring Assets ...................................................... 28
Configuring ENTIS for data synchronization .............. 20
Configuring ENTIS for File Replication ....................... 17
Configuring Station connections for Server
Redundancy ................................................................. 21
CONFIGURING THE ENTIS SYSTEM ............................. 25
Building Channels ...................................................... 34
Building Controllers .................................................... 39
Configuring Assets ...................................................... 28
Loading Asset Model on to Servers in the System 31
Starting Configuration studio ................................ 25
Copyright 2019 Honeywell ........................................... ii
CREATING FLEX OR CLIENT STATIONS ....................... 53

D

Downloading Controllers ................................................ 42
Downloading the Equipment Templates ........................ 50

E

ENTIS – Install Shield Wizard ......................................... 5
ENTIS as a Client .......................................................... 2
ENTIS as a Server .......................................................... 2

H

HARDWARE REQUIREMENTS ........................................ 2
ENTIS as a Client .......................................................... 2
ENTIS as a Server .......................................................... 2

I

INSTALLATION OF ENTIS ........................................... 4
.NET framework 4.7.2 framework ................................ 5
Installing ENTIS as Server ........................................... 5
Prerequisites ............................................................... 4
Installing ENTIS as Client or User Interface ................. 23
Verifying successful installation ............................... 24
Installing ENTIS as Server ........................................... 5
Installing ENTIS with Redundancy .............................. 10
Configuring ENTIS for data synchronization ............ 20
Configuring ENTIS for File Replication .................... 17

Configuring Station connections for Server
Redundancy ................................................................. 21
Non-redundant ............................................................ 10
Non-redundant ENTIS hosting redundant CIU’s .......... 11
Redundant with Single network .................................. 12
INSTALLING THE ENTIS LICENSE ............................. 56
Uninstall ENTIS program ........................................... 56
INTRODUCTION ......................................................... 1

L

Legal aspects .............................................................. ii
Loading Asset Model on to Servers in the System ......... 31

M

MIGRATING CIU 888 DATABASE
Downloading the Equipment Templates ........................ 50
MIGRATING CIU 888 DATABASE ................................ 44

N

Non-redundant ............................................................ 10
Non-redundant ENTIS hosting redundant CIU’s .......... 11

Q

Quick Builder - Channel ........................................... 34
Quick Builder - Controller .......................................... 39
Quick Builder - Equipment ........................................ 50
Quick Builder - Station ............................................... 53

R

Redundant with Single network .................................. 12
Commissioning .......................................................... 13
Configure arbitration .................................................. 14
Defining the data links .............................................. 15
Prerequisites ............................................................. 12
References .......................................................... ii, iii, 28

S

Safety and prevention of damage ................................ ii
SETUP LOGGING SETTINGS ........................................... 55
SOFTWARE REQUIREMENTS ....................................... 3
Prerequisite Software .................................................. 3
Starting Configuration studio ................................... 25
Support ................................................................. iii

U

Uninstall ENTIS program ........................................... 56

V

Verifying successful installation ............................. 24
For service-related questions, contact:

Technical Assistance Centre
Phone: +31152701246
E-mail: HFS-TAC-SUPPORT@honeywell.com

Copyright © 2019 - Honeywell
All rights reserved. No part of this manual may be reproduced in any form, by print, photoprint, microfilm or any other means without the written permission from Honeywell.

For more information
To learn more about ENTIS,
visit www.honeywellprocess.com
Or contact your Honeywell Account Manager

Americas
Honeywell Enraf Americas, Inc.
1250 West Sam Houston Pkwy S.
Houston, TX 77042
USA
Phone: +1 (480) 293-2042
Email: enraf-us@honeywell.com

Europe, Middle East and Africa
Honeywell Enraf
Delftechpark 39
2628 XJ Delft
The Netherlands
Phone: +31 (0)15 2701 100
Email: enraf-nl@honeywell.com

Asia Pacific
Honeywell Pte Ltd.
17 Changi Business Park Central 1
Singapore 486073
Phone: +65 6355 2828
Email: enraf-sg@honeywell.com